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Notice

1.

13.
14,

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

. Itis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)’ means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.

Trademarks
Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.

© 2021 Renesas Electronics Corporation. All rights reserved.



General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between ViL (Max.)
and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi4 (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LSl is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The useris advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Smart Configurator) for RX together with the CS+ IDE to create a working project for the RSK+ platform. It is
intended for users designing sample code on the RSK+ platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX671 microcontroller may be found in ‘RX671 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK+ installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX671 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK+ Renesas Starter Kit+ for R20UT4879EG
hardware. RX671 User’s Manual
Tutorial Manual Provides a guide to setting up RSK+ Renesas Starter Kit+ for R20UT4880EG
environment, running sample code and RX671 Tutorial Manual
debugging programs.
Quick Start Guide Provides simple instructions to setup the RSK+ | Renesas Starter Kit+ for R20UT4881EG
and run the first sample. RX671 Quick Start Guide
Smart Configurator Provides a guide to code generation and Renesas Starter Kit+ for R20UT4882EG
Tutorial Manual importing into the CS+ IDE. RX671 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK+. Renesas Starter Kit+ for R20UT4878EG
RX671 Schematics
Hardware Manual Provides technical details of the RX671 RX671 Group User’s RO1UHO899EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi§ is a Digilent Pmod™ ngpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE
Smart Configurator to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:

« Project Creation with CS+

« Code generation using the Smart Configurator.

o User circuitry such as switches, LEDs and a potentiometer

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT4882EG0100 Rev. 1.00 Page 8 of 69
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Renesas Starter+ Kit for RX671 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator for the RX family
together with the CS+ IDE to create a working project for the RSK+ platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the Smart Configurator for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
o ‘Debug’ is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and no ‘Outputs debugging information’
options not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT4882EG0100 Rev. 1.00 Page 9 of 69
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Renesas Starter Kit+ for RX671

3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX671

MCU, ready to generate peripheral driver code using Smart Configurator.

This project generation step is

necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:

Windows™ 8.1: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

e CS+ will show the Start Page.
the ‘GO’
Project.

Use
button to Create a New

Create New Project

A new project can be crested.
A new project can also be created by reusing the file configuration registered to an existing project.

e In the ‘Create Project’ dialog, select

‘RX’ from the ‘Microcontroller’ pull-
down.
e In the ‘Using Microcontroller’ list

control, scroll down to ‘RX671 and
expand the tree control by clicking ‘+'.
Select ‘R5F5671EHXFB (144pin).

e Ensure that in the ‘Kind of project’ pull-
down, ‘Application(CC-RX)’ is selected.

e Choose an appropriate name and
location for the project, then click
‘Create’.

Note: this tutorial assumes the project
is named and located at the place
shown opposite.

e If the folder entered cannot be found a
‘Question’ dialog will be displayed;
click ’Yes’.

Create Project

Microcontroller: R -

Using microcontroller:
5, (Search microcontroller)

M R5F5571EH.FE_DUAL({144pin)
i R5F5671EHKFM(B4pin)
M R5F5671EHxFM_DUAL(E4pin)
M R5F5671EHXFP(100pin)
M R5F5671EH:.FP_DUAL{100pin)
¥ R5F5671EHxLE(145pin)
M R5F5671EHxLE_DUAL(145pin)

S OECECTA Tl 17400

Update...

Product Name:R5F5671EH«FB

On-chip ROM size[KBytes]: 2048

On-chip RAM size[Bytes]: 353216

Additional Information:Package=PLOP0144KA-B

W

Kind of project: Application(CC-RX) -
Project name: SC_Tutorial
Flace: C\\workspace e Browse...

Make the project folder

C:Wiorkspace\SC_Tutorial\SC_Tutorial mtpj

[] Pass the file composition of an existing project to the new project

Project to be passed: Erowse...
Copy composition files in the diverted project folder to a new project folder.
= [ =

e CS+ will create the blank project with

™ SC_Tutorial - CS+ for CC - [Project Tree]

the _Standard project tree. A ‘Smart | g. e view Project Build Debug Tool Window Eelp
Configurator’ node may also be @ st | B G X B 00 O g A & . &
shown, if previously enabled. D ) B G @B B RS @ Sotonlin == —
=) 3 | [E
g ‘ @ 3 @ D:'l Smart Configurator Property
=|| = gSC Tutorial (Project) v Product Informsion
E E R5F5671EHxFB (Microcontroller) Version
= 2| Smart Configurator (Design Tool) ~ Smart configurator selting
CC-RX (Build Tool)
#, RX Simulator (Debug Tool)
b Program Analyzer (Analyze Tool)

May.10.21




Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

4. Smart Configurator Using the CS+

4.1 Introduction

The Smart Configurator for the RX671 has been used to generate the sample code discussed in this
document. Smart Configurator for CS+ is a tool for generating template ‘C’ source code and project settings
for the RX671. When using Smart Configurator, it provides the user with a visual way of configuring the target
device, clocks, software components, hardware resources and interrupts for the project. Thereby bypassing
the need in most cases to refer to sections of the Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called SC_Tutorial. A fully
completed Tutorial project is contained in the RSK+ Web Installer
(https://www.renesas.com/rskrx671/install/cs) and may be imported into CS+ by following the steps in the
Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these moddules to perform A/D conversion. Results are
displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the
RSK+.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator.

R20UT4882EG0100 Rev. 1.00 RENESAS Page 11 of 69
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: CS+.
You can download the latest document from: https://www.renesas.com/smart-configurator.

Smart Configurator will start up by double clicking on “Smart Configurator (Design Tool)” in the project tree.
The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

Smart Configurator
File Window Help

HE Al
{5 SC Tutorial.scfg 32 = 0O | & MCU/MPU Package &2 = d
jewi ; i "] 3 z
Q (] L ] »
Overview information o e E -] L[| S s [ || [ Assig...

- General Information @ 2

This editor allows you to modify the settings stored in configuration file (.scfg)

Board
Allow board and device selection

Application under
Clocks development

Allow clock configuration

" | =Ccomponents ¢
[M\dd\ewafﬂ l RENESAS
Components Device
driver | RTOS |

Allow software component selection and cenfiguration
= Pins

Pins

RSF5671EHxFB

Allow general pin configuration and pin configuration for selected software component

Interrupt
Allow general interrupt configuration and interrupt canfiguration for selected software component

~ Cunrent Configuration
Overview | Board | Clocks | System | Components | Ping | Interrupts » Legend
& Console &2 =~ = B ||[Z Configuration Problems % L v =8

No consoles to display at this time. Ditems

Description Type

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project that builds and runs without error.

R20UT4882EG0100 Rev. 1.00 REN ESNS Page 12 of 69
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

Device selection

Device selection

Board:  |Custom User Board V)

Device: | RSFSE71EH=FB

Owverview | Board | Clocks | System | Components | Pins | Interrupts

%l &
Generate Code Generate Report

By e

Figure 4-2 The ‘Board’ tabbed page

4.3.1 Board configuration

Make sure that ‘Custom User Board’ is selected for the ‘Board:’.

Device selection

Device selection

Board: I>Cu stom User Board

Device: | RSF5671EHxFB

Figure 4-3 Select board

R20UT4882EG0100 Rev. 1.00 RRENESAS
May.10.21
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected to
‘r_bsp_config.h’ file in ‘Smart Configurator\r_config’ of project tree.

441 Clocks configuration

Figure 4-4 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on-board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-4.

ez =
Clocks configuration c
9 Generate Code Generate Report
SCKCR (FCK[3:0]) FlashlF clock (FCLK)
Ve | 33 V) (Actual value: 3.3) T L &0 L
Frequency Division: SCKCR (ICK[3:0D) System clock (ICLK)
. « . — x1/2 - 120 (MHz)
| Main clock : — SCKCR (PCKA[3:0)) Peripheral module clock (PCLKA)
o requency Multiplication: — 2 . 120 (MHz)
Oscillation source: | Resonator > x10.0 -
= SCKCR (PCKB[3:0]) Peripheral module clock (PCLKE)
Frequency: 24 {MHz) —® L @ b 14 . 0 (MH2)
Oscillation wait time: SCKCR (PCKC[3:0]) Peripheral module clock (PCLKC)
9980 {ps) (Actual value: 10000) —e— x1/4 - 60 (MHz)
SCKCR (PCKD[2:0]) Peripheral module clock (PCLKD)
p— x1/4 - 60 {MHz)
Sub-clock SCKCR (BCK[3:0]) External bus clock (BCLK)
— x1/2 - 120 (MHz)
BCKCR (BCLKDIV)
[ =
SCKCR2 (UCK[3:0])
HOCO clock L
L] CKOCR (CKODIV[2:0]) CLKOUT pin
xl -
LOCO clock
CANMCLK/CACMCLE
24 (MHz)
IWDT-dedicated clock |
Overview anrdlCIocksI System | Components | Pins | Interrupts
H & ’
Figure 4-4 The ‘Clocks’ tabbed page
R20UT4882EG0100 Rev. 1.00 RENESAS Page 14 of 69
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

4.5 The ‘System’ tabbed page

Set the On-chip debug setting mode on the ‘System’ tabbed page.

o -
System configuration C. =

4 9 Generate Code Generate Report
¥ On-chip debug setting

Debug interface setting

(® Unused () FINE O ITAG () ITAG (Trace)

Overview | Board | Clocks I Systeml Components | Pins | Interrupts

Figure 4-5 The ‘System’ tabbed page

451 On-chip debug setting

The On-chip debug settings set the interface used for debugging. For the RSK+RX671 CPU board, select
JTAG as shown in Figure 4-6.

* On-chip debug setting
Debug interface setting

() Unused () FIME

() ITAG (Trace)

Mote: The using of PC7/UB may have a limitation, because PC7/UB is controlled for mode-settings by emulator.

Figure 4-6 Debug interface setting
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

4.6 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

Software component configuration

Components = ::: »  Configure
W
type filter text
v (= Startup
w = Generic
& rbsp

Overview | Board | Clocks | System Eomponent;! Pins | Interrupts
Figure 4-7 Components page

4.6.1 Add a software component into the project

Smart Configurator supports four types of software components: Startup, Drivers, Middleware and Application.
In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ W icon.

Software component configuration

Components b =) v

type filter text

v [= Startup
w [ Generic

& rbsp

Figure 4-8 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Mew Component

Software Component Selection
Select component from those available in list .dj
Type All ~
Function o
Filter
1

Figure 4-9 Add a Software component (2)
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4. Smart Configurator Using the CS+

4.6.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as
timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-10 below then click ‘Next'.

Mew Component

Software Component Selection

Select component from those available in list

Category | Drivers

Function |All ~
Filter |

Components . Type Version 2

H 5-Bit Timer Code Generator 1.80

 Buses Code Generator 1.8.0

8 Clock Frequency Accuracy Measurement Circuit Code Generator 1.8.0

3 Compare Match Timer Code Generator 2.1.0 i

ECDmpIementary PWM Mode Timer Code Generator 1.8.0

# Continuous Scan Mode S12AD Code Generator 111.0

8 CRC Calculator Code Generator 1.8.0

## Data Operation Circuit Code Generator 1.9.0

8 Data Transfer Controller Code Generator 1.8.0

# Dead-time Compensation Counter Code Generator 1.2.0 v

Show only latest version
Hide items that have duplicated functionality

Description

«can generate interrupts at set intervals,

This software component provides configurations for 16-bit/32-bit timer with module CMT/CMTW and

Download more software components

Configure general settings...

® < Back

Mext > || Finich

Cancel

Figure 4-10 Select Compare Match Timer
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO’ as shown in Figure 4-11
below.

New Component

Add new configuration for sel d |
Compare Match Timer
Configuration name: ‘Confiq_CMTWO ‘
Resource: CMTWo ~
CMTWO
CMTW1
CMT1
cMT2
CMT2
@ < Back Next > Cancel

Figure 4-11 Select Resource - CMT0

Ensure that the ‘Configuration name’ updates to ‘Config_ CMTQ’ as shown in Figure 4-12 below then click
‘Finish’.

New Component

Add new configuration for sel d
Compare Match Timer
Configuration name: IConfiq_CMTO I
Resource: MTo ~
o)
@ < Back Nect> Cancel

Figure 4-12 Ensure Configuration name - CMT0

In ‘Config_ CMTQ’, configure CMTO as shown in Figure 4-13. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

Components i i = Configure
% Count clock setting
- @ PCLK/S (O PCLK/32 (O PCLK/28 O PCLK/512
type filter text
v G Startup = Compare match setting
v [= Generic Interval value |1 I Ims VI (Actual value: 1)
& rbsp Register value (CMCOR) (7499 |
w [= Drivers
w [= Timers Compare match interrupt (CMI0)
- Config_CMTO g :
IO Priority licveiio v

Figure 4-13 Config_CMTO setting
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-14 below.

New Component

Add new config for d |
Compare Match Timer
Configuration name: | Config_CMTW0
Resource: CMTWO ~

@ <Back Next >

Figure 4-14 Select Resource — CMT1

Cancel

Ensure that the ‘Configuration name’ updates to ‘Config_CMT1’ as shown in Figure 4-15 below then click
‘Finish’.

New Component

Add new configuration for selected component |
Compare Match Timer
‘Configuration name: IConfig_CMTT I
Resource: CMT1 S
® = Back Next > Cancel

Figure 4-15 Ensure Configuration name — CMT1

Navigate to the ‘Config_CMT1’ and configure CMT1 as shown in Figure 4-16. This timer is configured to

generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Components B - Configure
% = Count clock setting
(O PCLK/E ® PCLK/32| (O PCLK/128 (O PCLK/512
type filter text -
v (= Startup = Compare match setting
w [= Generic Interval value IZO I Ims VI (Actual value: 20)
@ rbsp Register value (CMCOR) 37499 |
w [ Drivers
v (= Timers Compare match interrupt (CMIT)
& Config_CMTO e g :
- P [Level 10 e
&+ Config_CMT1 oty L - |

Figure 4-16 Config_CMT1 setting
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-17 below.

New Component

Add new config ion for sel d |
Compare Match Timer
Configuration name: | Config_CMTW0
Resource: CMTWO ~
CMTWO
CMTW1
CMTO
CMT1
CMT3
@ <Back Next > Cancel

Figure 4-17 Select Resource — CMT2

Ensure that the ‘Configuration name’ updates to ‘Config_CMT2’ as shown in Figure 4-18 below then click
‘Finish’.

New Component

Add new configuration for selected component

Compare Match Timer

‘Configuration name: IConfig_CMTZ I

Resource: MT2

® = Back Next >

==

Figure 4-18 Ensure Configuration name — CMT2

Navigate to the ‘Config_CMT2" and configure CMT2 as shown in Figure 4-19. This timer is configured to

generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Components = ::: ~  Configure
% = Count clock setting
- (O PCLK/E (O PCLK/32 OPCLK/128 (@ PCLK/512
type filter text
v (= Startup N Compare match setting
w [= Generic Interval value IZOD I Ims VI (Actual value: 200.004267)
odiens Register value (CMCOR) (23437 |
v [= Drivers
v (= Timers Cornpare match interrupt (CMI2)
& Config_CMTO e g :
P fLevel 10 e
& Config_CMT1 oty L |
& Config_CMT2

Figure 4-19 Config_CMT2 setting
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Renesas Starter Kit+ for RX671

4. Smart Configurator Using the CS+

4.6.3 Interrupt Controller

Referring to the RSK+ schematic, SW1 is connected to IRQ9(P91) and SW2 is connected to IRQ10 (P92).
SW3 is connected to IRQ15(P07) and ADTRGON. This tutorial uses ADTRGOnN, which will be configured later

in §4.6.7.
Click the ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Interrupt Controller’ as shown in Figure 4-20 then click ‘Next'.

New Component

Software Component Selection
Select component from those available in list Hj-
Category I Drivers VI
Function | All v
Filter | |
I
Components Type Version L
8 Event Link Controller Code Generator 17.0
B2 Group Scan Mode $12AD Code Generator 1100
## 12C Master Mode Code Generator 1100
£ 12C Slave Mode Code Generator 1.9.0
H Interrupt Controller Code Generator 2.1.0 |
# Low Power Consumption Code Generator 210
H# Normal Made Timer Code Generator 1.10.0
8 Phase Counting Mode Timer Code Generator 220
8 Port Output Enable Code Generator 1.9.0
# Ports Code Generator 2240 v
. R - -
Show only latest version
Hide items that have duplicated functionality
Description
Interrupt Controller configures the interrupt requests generated by ICU: Software interrupt, NMI pin
interrupt and IRQ External pin interrupts.
Download more software components
Configure general settings...
® < Back I Next » I I Einish I Cancel

Figure 4-20 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘ICU’ as shown in Figure 4-21

below then click ‘Finish’.

New Component

®

Add new config for sel d p |
Interrupt Controller
Configuration name: | Config_ICU
Resource: Iy ~

< Back

Next »

Cancel

Figure 4-21 Select resource — ICU
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Renesas Starter Kit+ for RX671

4. Smart Configurator Using the CS+

Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-22

below.
Components 12 : Configure @
. Software interrupt setting
type filter text [ Software interrupt
- & Swrp . [ Software interrupt 2
~ 1= Generic Priarity Level 15 (highest)
& rbsp
v = Drivers MMI pin interrupt setting
v & Inferrupt [ NMI pin interrupt Detection type [Falling edge Digital filter [Nofilter 0 (MHz)
& Config_ICU
v & Timers IRQO setting
@ Config CMT0 Jrao Detecti Low level Digital filter |[Nofill 0 rAH
& Config, CMTH ection type | Low leve igital filter | Mo filter 0 {MHz)
@ Config CMT2 Priority | Level 15 (highest)
IRQ1 setting
CJIrRG Detection type [Low level Digital filter [Nofilter o (MHz)
Priarity | Lewel 15 (highest)
IRQ2 setting
w [Ira2 Detection type [Low level Digital filter [Nofilter o (MHz)
Priarity |Level 15 (highest)
IRQ3 setting
Oras Detection type | Low level Digital filter | N filter 0 (MHz)
Priority | Lewel 15 (highest)
IRQ4 setting
1RG4 Detection type [Low level Digital filter [Nofilter o (MHz)
Priarity | Lewel 15 (highest)
IRQS setting
iras Detection type [Low level Digital filter [Nofilter o (MHz)
Priarity |Level 15 (highest)
IRQ6 setting
Cras Detection type | Low level Digital filter | N filter 0 (MHz)
Pricrity | Lewel 15 (highest)
IRQ7 setting
JIrg? Detection type [Low level Digital filter [Nofilter 0 (MHz)
Priarity | Lewel 15 (highest)
IRQS setting
[Iras Detection type [Low level Digital filter [Nofilter o (MHz)
Priarity |Level 15 (highest)
IRQ9 setting
Elrae Detection type Digital filter | No filter 0 {MHZ)
Priority | Level 15 (highest) ~
IRQ10 setting
Erae Detection type | Falling edge v|  Digital fiter | No filter 0 {MHz)
Priarity | Level 15 (highest) “
IRQ11 setting
Ira Detection type [Low level Digital filter [Nofilter o (MHz)
Priarity |Level 15 (highest)
IRQ12 setting
iRtz Detection type | Low level Digital filter | Nafilter a (MHz)
Pricrity | Lewel 15 (highest)
IRQ13 setting
[JIrQi2 Detection type [Low level Digital filter [Nofilter 0 (MHz)
Priarity | Level 15 (highest)
IRQ14 setting
[Ira14 Detection type [Low level Digital filter [Nofilter o (MHz)
Priarity |Level 15 (highest)
IRQ15 setting
irats Detection type | Low level Digital filter | Nafilter a (MHz)
Pricrity | Lewel 15 (highest)
Figure 4-22 Config_ICU setting
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Renesas Starter Kit+ for RX671

4. Smart Configurator Using the CS+

4.6.4 Ports

Referring to the RSK+ schematic, LEDO is connected to P17, LED1 is connected to PF5, LEDZ2 is connected
to PO3 and LED3 is connected to P05. PJ3 is used as one of the LCD control lines, together with P74, P71

and P72.
Click the ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.
Select ‘Ports’ as shown in Figure 4-23 then click ‘Next'.

New Component

Software Component Selection

Select component from those available in list

Category I Drivers

# PWM Mode Timer

PO

Function | All ~
Filter | |
Compenents - Type Wersion &
8 12C Master Mode Code Generator 1100
2 12C Slave Mode Code Generator 1.9.0
8 Interrupt Controller Code Generator 21.0
8 Low Power Consumption Code Generator 21.0
8 Normal Mode Timer Code Generator 1.10.0
8 Phase Counting Mode Timer Code Generator 220
H# Port Output Enable Code Generator 1.9.0
= Ports Code Generator 2.2.0 |
£ Programmable Pulse Generator Code Generator 150
1100

Code Generator

Show only latest version

Description

Hide items that have duplicated functionality

This software companent generates two units (unit 0, unit 1) of an on-chip &-bit timer (TMR) module
that comprise two 8-bit counter channels, totaling four channels,

Download more software components

Configure general settings...

@

<Back | Next> || Finish |

Cancel

Figure 4-23 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-24

below then click ‘Finish’.

New Component

Add new configuration for selected component

Ports
Configuration name: | Config_PORT
Resource: PORT ~

@

< Back

Next >

Cancel

Figure 4-24 Select resource — PORT

R20UT4882EG0100 Rev. 1.00
May.10.21

RRENESAS

Page 23 of 69



Renesas Starter Kit+ for RX671

4. Smart Configurator Using the CS+

Tick the tickboxes for ‘PORTQ’, ‘PORT1’, PORT7’, ‘PORTF’ and ‘PORTJ’ as shown in Figure 4-25 below.

Components = }:{} ~  Configure
e Portselection PORTO PORT1 PORT7 PORTF PORT
type filter text
v (= Startup -
v (= Generic PORTO PORT1
& rbsp
~ [= Drivers [IPORT2 CJPORT3
v [= Interrupt
@ Config_ICU [JPORT4 [JPORTs
w [= /O Ports
& Config_PORT [JPORTE PORT?
v (= Timers
& Config_CMTo [1PORTa []PORTS
& Config_CMT1
& Config_CMT2 [CJPORTA CJPORTB
[JpORTC []PORTD
[1PORTE PORTF
CJPORTH

Figure 4-25 Select Port selection

Navigate through each of the ‘PORTX’ tabs, configuring these four 1/O lines and LCD control lines as shown in
Figure 4-26, Figure 4-27, Figure 4-28, Figure 4-29 and Figure 4-30 below. Tick the tickboxes for ‘Out’ and
tick ‘Output 1’ the tickboxes except for P72 under the ‘PORT7’ tab. Start with the 'PORTOQ' tab.

Components B o Configure @
- Port sslectiDnPORﬁ PORT7 PORTF PORTI
type filter text
w [= Startup -
Apply to all
v (= Generic U PPy
& rbsp Unused GPIO In Out Pull-up CMOS output Output 1
w [ Drivers
v = Interrupt Poo
@ Config_ICU @Unused GPIO. Oln - O 0ut  [JPull-up | CMOS sutput ~ Output 1 ~
v = IO Ports
& Config PORT Pl
w = Timers
& Config CMTo @Unused GPIO. Oln - O0Cut  [JPull-up | CMOS cutput v Output 1 -
& Config_CMT1
& Config CMT2 Foz
@UnusedGPIO. Oin O 0ut  [JPull-up | CMOS cutput ~ Output 1 Mormal drive output -
Po3
OUnused GPIO Oin Pull-up CMOS output ~
Pos
OUnused GPIO Oln Pull-up  |CMOS output ~
v
Po7
®UnusedGPIC OIn - O0ut OPullup  |CMOS sutput ~ Output 1
Figure 4-26 Select PORTO tab
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

13 ’
Select ‘PORT1’ tab.
Components [EA=] o Configure @
L Port selection PORTo [ PORTI | PORT? PORTF  PORT)
type filter text
w [ Startup -
Apply to all
v (= Generic Dlapely
& rbsp Unused GPIO In Out Pull-up CMOS output Output
v [= Drivers
v = Interrupt P12
@ Config_ICU @UnusedGPIO. Oln - O 0ut  Pull-up | CMOS sutput ~ Output 1 | Mormal drive output ~
w (= /O Ports
& Config PORT 13
w = Timers
& Config CMTo @Unused GPIO. Oln - O0Cut  [JPull-up | CMOS cutput v Output 1 Normal drive output v
& Config_CMT1
& Config CMT2 P14
@Unused GPIO. Oin O0ut  [JPull-up | CMOS output v Output 1 Normal drive output ~
Pis
@UnusedGPIO. Oin O 0ut  [JPull-up | CMOS cutput ~ Output
P16
@ UnusedGPIO OIn - O0ut  [JPull-up  |CMOS output ~ Output
v
P17
Ounused G210 Oln Pull-up  [CMOS output - High-drive output v
Figure 4-27 Select PORT1 tab
13
Select ‘PORT7 tab.
Components L= 2 + | Configure ®
L Port selection  PORTO  PORT1 PORTF PORT)
type filter text
w (= Startup ~
Apply to all
~ [~ Generic u PRy
& rbsp Unused GPIO In Out Pull-up  CMOS output Output 1
w [= Drivers
~ (= Interrupt P70
& Config_ICUI @ UnusedGPIC. Oln - O0ut  [JPull-up | CMOS output - Output 1 | High-drive output ~
v [= IO Ports
& Config PORT -
~ [= Timers
& Config CMTo QunusedGPI0. O'n [@0um] [ 1pullup [ CMOSoutput v
& Config_CMT1
@& Config CMT2 P72
QunusedGPI0. O'n [@0u] [ 1pullup [ cMOScutput v [Output1 |Normal drive output v
P73
@ UnusedGPIO Oln Q0ut  [JPull-up | CMOS output ~ Qutput High-drive output ~
P74
O Unused GPIG Oln - Pull-up ‘CMOS output w Normal drive output ™
W
P75
@ UnusedGPIO. Oin Q0w [JPull-up ‘CMOS output w Output Normal drive output ™
P76
@ UnusedGPIC. On - O0ut  [JPull-up | CMOS output ~ Output 1 Normal drive cutput ~
P77
@ UnusedGPIC. On - O0ut  [JPull-up | CMOS output ~ Output 1 Normal drive cutput ~
Figure 4-28 Select PORT7 tab
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4. Smart Configurator Using the CS+

Select ‘PORTF’ tab.

Components 12 B8 £ Configure ®
Portselection  PORTO  PORT1 PORT7 [ PORIF | PORT)
type filter text
N %} ;:rgj'lenc Dlapsiy toal
& rhsp Unused GPIO In Out Pull-up CMOS output Cutput 1
~ [= Drivers
w [ Interrupt PFs
& Config ICU OUnused GPIO Oln Pull-up | CMOS output -
v = /O Ports
& Config_PORT
v (= Timers
& Config CMTo
& Config_CMT1
& Config CMT2
Figure 4-29 Select PORTF tab
Select ‘PORTJ tab.
Components Configure [©)]
Port selection PORTO PORT1 PORT7 PORTE [PORT |
type filter text
w (= Startup Appl I
~ [~ Generic o pply to 2
& rbsp Unused GPIC In Out Pull-up CMOS output Output 1
w [ Drivers
~ (= Interrupt Pl3
& Config_ICU OUnused G0 Oln Pullup  |CMOS output v
v [= IO Ports
& Config PORT s
~ [= Timers
& Config CMTo @ UnusedGPI0 Oln O0ut  [Pull-up | CMOS output w Output 1
& Config_CMT1
& Config CMT2
Figure 4-30 Select PORTJ tab
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the CS+

4.6.5 SCI/SCIF Asynchronous Mode

In the RSK+RX671, SCI10 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as
shown in the schematic.

Click the ‘Add component’ & icon.
In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SCI/SCIF Asynchronous Mode’ as
shown in Figure 4-31 then click ‘Next’.

New Component

Software Component Selection
Select component from those available in list E
Category I Drivers VI
Function | All v
Fiter | |
=

Components Type Version ()

# Real Time Clock Code Generator 160

## Remote Control Signal Receiver Code Generator 1.1.0

1 SCI/SCIF Asynchronous Mode Code Generator 1.10.0 i

## 5CI/SCIF Clock Synchrenous Mode Code Generator 1.10.0

8 Single Scan Mode S12AD Code Generator 23.0

H# Smart Card Interface Mode Code Generator 1100

# 5PI Clock Synchronous Mode (3-wire method) Code Generator 1.10.0

#sel Operation Mode (4-wire method) Code Generator 1.80

BVD\lage Detection Circuit Code Generator 1.9.0

## Watchdog Timer Code Generator 190 v

Show only latest version
Hide items that have duplicated functionality

Description

This software component provides configurations for SCI(SCIF) single{multi-processor) asynchronous
mode.

Download more software components

Configure general settings...

® < Back I Next » I I Einish I Cancel

Figure 4-31 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as
shown in Figure 4-32 below.

New Component

SCI/SCIF Asynchronous Mode

Configuration name: | Config_SClo

Work mode: Transmission ~

Transmission

Resource:

on
nsmission
Multi-processor Reception

Multi-processor Transmission/Reception

® < Back Next > Cancel
Figure 4-32 Select Work mode — Transmission/Reception
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4. Smart Configurator Using the CS+

In ‘Resource’, select ‘SCI10’ as shown in Figure 4-33 below.

New Component

Add new configuration for selected component

SCI/SCIF Asynchronous Mode

Configuration name: | Config_SCIO

Work mode: Transmission/Reception

Resource: sCho

sClo
5Ch
sCiz
sCi2
SCI4
SCls
5Cle
sci7
sCle
]

SCH1
SChz

® < Back Mext >

o

Figure 4-33 Select Resource — SCI10

Ensure that the ‘Configuration name’ is set to ‘Config_SCI10’ as shown in Figure 4-34 below then click ‘Finish’.

MNew Component

Add new configuration for selected component E}
SCI/SCIF Asynchronous Mode
Configuration name: ICanig_SCI‘IO I
Work mode: Transmission/Reception -
Resource: 5CHo ~
® < Back Next > Cancel

Figure 4-34 Ensure Configuration name - Config_SCI10
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Configure SCI10 as shown in Figure 4-35. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD10 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components = :'.# ~  Configure @
W w FIFQ mode setting
type filter text (® Non-FIFO mode (O FIFO mode
v [= Startup - Start bit edge detection setting
~v [= Generic (O Low level on RXD10 pin
& rbsp .
v (= Drivers Data length setting
v @ Interrupt O 9bits @) & bits O 7 bits
= T"O EOTQ'ICU Parity setting
- 70 Ports
- N E Odd
& Config PORT ® Hore Ofven o
v = Communications Stop bit length setting
& Config_SCI0 @ 1bit () 2 bits
w [= Timers
& Config CMTo Transfer direction setting
& Config_CMT1 (®) LSB-first () MSB-first
» Config CMT2
. 9- Data inversion setting
(® Mormal O Inverted
Instant transmission setting
[ Enable instant transmission
Transmitter cutput setting
™ (® Normal O Inverted
Receiver input setting
(® Normal O Inverted
Transfer rate setting
Transfer clock Internal clock ~
Base clock 16 cycles for 1-bit period ~
Bitrate | 19200 ~|  (bps) (Actual value: 19230.758, Error: 0.
[ Enable medulation duty correction
SCK10 pin function SCK10is not used ~
Transfer timing adjustment setting
] Adjust transmit signal transition Does not change the waveform
] Adjust receive data sampling 3 clocks later than default point
Moise filter setting
(] Enable noise filter
Clock signal divided by 1 20000000
Hardware flow control setting
(® None O TS0 (O RTS10#
15
FIFQ data setting
0
8
Data match detection setting
] Enable data match detection
0x00
Data handling setting
Transmit data handling Data handled in interrupt service routine ~
Receive data handling Data handled by DTC ~ (Please ensure DTC config is added)
Interrupt setting
TXI0 pricrity Level 15 (highest) ~
RX10 priority Level 15 (highest) ~
Enable reception error interrupt (ERI0)
TENQ, ERNO priority (Group ALQ) Level 15 (highest) ~
Receive data ready interrupt Receive data full interrupt (RXI)
Callback function setting
[ Transmissicn end Recepticn end Reception error
Figure 4-35 Config_SCI10 setting
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4.6.6 SPI Clock Synchronous Mode

In the RSK+RX671, SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click the ‘Add component’ & icon.

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as

shown in Figure 4-36 then click ‘Next'.

New Component

Software Component Selection

Select component from those available in list

Category I Drivers

Function | All v
Filter | |
Components . Type Version ()
8 Real Time Clock Code Generator 1.60
## Remote Control Signal Receiver Code Generator 11.0
8 5CI/SCIF Asynchronous Mode Code Generator 1.10.0
8 5CI/SCIF Clock Synchronous Mode Code Generator 1.10.0
8 Single Scan Mode S12AD Code Generator 23.0
# Smart Card Interface Mode Code Generator 1.10.0
7 SPI Clock Synchronous Mode (3-wire method) Code Generator 1,100 1
% SPI Operation Mode (4-wire method) Code Generator 180
BVD\laqe Detection Circuit Code Generator 1.9.0
# Watchdog Timer Code Generator 1.9.0 v

Show only latest version
Hide items that have duplicated functionality

Description

This component provides clock synchronous operation of RSPI or SCI (Simple SPI bus). It includes 4
transfer medes: Slave transmit/receive, Slave transmit, Master transmit/receive and Master transmit,

Download more software components

Configure general settings...

® < Back

Next> || Einish

Cancel

Figure 4-36 Select SPI Clock Synchronous Mode

In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown

in Figure 4-37 below.

New Component

Add new configuration for selected component

SPI Clock Synchronous Mode (3-wire method)

‘Configuration name: ‘ Config_RSPI0

Operation: Slave transmit/receive

Slave transmit/receive
Slave transmit only
Slave receive only

Resource:

Master tran ;mi&rec eive

® < Back

Cancel

Figure 4-37 Select Operation — Master Transmit
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In ‘Resource’, select ‘SCI6" as shown in Figure 4-38 below.

New Component

Add new configuration for selected component

SPI Clock Synchronous Mode (3-wire method)

Configuration name: | Config_RSPI0

Operation: Master transmit cnly

Resource: sy

RSPIO
RSPI1
RSPI2
SClo
5Ch
SCiz
sCI3
SCl4
S5CI5

SCI7
SClg
5Cle
sCha
sCIn
sChz

©)

< Back

Next >

Cancel

Figure 4-38 Select Resource — SCI6

Ensure that the ‘Configuration name’ is set to ‘Config_SCI6’ as shown in Figure 4-39 below then click ‘Finish’

New Component

Add new configuration for selected component -E-
SPI Clock Synchronous Mode (3-wire method)
Configuration name: ICanig_SCIS I
Operation: Master transmit cnly -
Resource: 5Cle ~
® < Back MNext = Cancel

Figure 4-39 Ensure Configuration name - Config_SCI6
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Configure SCI6 as shown in Figure 4-40. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’
is set to 15000 kbps. All other settings remain at their defaults.

Components =1 -
S
type filter text
w [ Startup ~
~ [= Generic
& rbsp
w [= Drivers
v [= Interrupt
& Config_ICU
v [= /O Ports
& Config PORT
+ [= Communications
& Config_SCl10
& Config_5Cl6
v [= Timers
& Config CMTo
& Config_CMT1
& Config_CMT2
v

Configure
Transfer direction setting
() LSE-first
Data inversion setting
(® Normal
Transfer speed setting
Transfer clock

Bit rate

O Inverted

Internal clock (SCKE pin functions as clock output pin) ~

(kbps) (Actual value: 15000, Error: 0%)

[JEnable medulation duty correction

Clock setting
[JEnable clock delay
Data handling setting

Transmit data handling
Interrupt setting
TXI6 priority

TEI6 priority (Group BLO)

Callback function setting

Transmission end

[CJEnable clock pelarity inversion

Data handled in interrupt service routine W
Level 15 (highest) ~
Level 15 (highest) ~

Figure 4-40 Config_SCI6 setting
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4.6.7

Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANOOO input, which is connected to the RV1
potentiometer output on the RSK+. The conversion start trigger will be via the pin connected to SW3. Click

the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select
‘Single Scan Mode S12AD’ as shown in Figure 4-41 then click ‘Next'.

New Component

Software Component Selection
Select component from those available in list .Hj
Category I Drivers VI
Function |All ~
Filter | |
=
Components Type Version 2
## Real Time Clock Code Generator 160
## Remote Control Signal Receiver Code Generator 1.1.0
8 sciysaF Asynchronous Mode Code Generator 1100
## SCI/SCIF Clock Synchronous Mode Code Generator 1.10.0
£ Single Scan Mode 512AD Code Generator 2.3.0 {
£ Smart Card Interface Mode Code Generator 1.10.0
# SPI Clock Synchrenous Mode (3-wire method) Code Generator 1.10.0
H#spl Operation Mode (4-wire method) Code Generator 1.80
E\Joltage Detection Circuit Code Generator 1.8.0
EWatchdog Timer Code Generator 1.8.0 v

Show only latest version
Hide items that have duplicated functionality

Description

This software component provides single scan mode configurations for 12-Bit A/D Converter which the
analog inputs arbitrarily selected are converted for only once in ascending channel order.

Download more software components

Configure general settings...

@ <Back | Mext> |[ Emsh | Cancel

Figure 4-41 Select Single Scan Mode S12AD

Ensure that the 'Configuration name' is'Config_S12ADQ' as shown in Figure 4-42 below then click ‘Finish’.

New Component

Add new configuration for selected t

Single Scan Mode S12AD

Configuration name: | Config_S12AD0

Resource: 512AD0 ~

® < Back MNext > Cancel

Figure 4-42 Ensure Configuration name - S12AD0
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Configure S12AD0 as shown in Figure 4-43 and Figure 4-44. Ensure the ‘Analog input channel’ tick box for
ANO0O0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings

remain at their defaults.

Components

type filter text

v [= Startup
v (= Generic
& rbsp
~ [= Drivers
v [= Interrupt
& Config_ICU
v (= A/D Converter
& Config_S12AD0
v (&= I/O Ports
& Config_PORT
v (= Communications
& Config SCHO
& Config 5Cl6
v (= Timers
& Config CMTo
& Config_CMT1
& Config CMT2

Configure

~ Basic setting

Note

When using the 12-bit A/D converter unit 0, do not use the P40 to P47, P03, P0OS, and PO7 pins as cutput pins,

We also recommend not using the P00 to POZ, P90, PDO to PD7, PEQ, and PE1 pins as output pins.

Analog input mode setting
[ Double trigger mode

Analog input channel setting

] ANODO ] ANoon [ anooz [ anoo3 [ aMoos

[ anoos [ anoos [ anoo7

Conversion start trigger setting

Start trigger source EA/D conversion start trigger pin vI

Interrupt setting

Enable AD conversion end interrupt (S12AD0) Priority Level 15 (highest) ~

~ Advance setting
Add/Average AD value setting
[JANo0o ANOD
ANO0OS ANOOE
Self diagnosis setting

Mode

Disconnection detection assist setting

Charge setting

ANDOZ ANOO3

ANOOT

Unused

av

Unused

2 ADCLK

AN

Figure 4-43 Config_S12AD0 setting (1)
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Data registers setting

Data placement

Automatic clearing
Conversion resolution
Addition/Average mode select
Addition count

Window function setting

(@) Disable

Window A/B operation setting
[JEnakle comparison window A

Window A/B complex condition

A/D comparison A setting

Reference data O for comparison

Reference data 1 for cornparison
Use comparator for ANDDD
Use comparator for ANOO1
Use comparator for AN0O2
Use comparator for ANOO3
Use comparator for ANOO4
Use comparator for ANOOS
Use comparator for ANDOE

Use comparator for ANOOT

A/D comparison B setting
Reference data O for comparison
Reference data 1 for cornparison

Comparison B channel

Input sampling time setting
ANOOO/Self-diagnosis
AMZT

ANDDZ

ANDDE

AN

AMNDDE

AMDDA

AMDIT

Interrupt setting

Enable AD conversion compare interrupt A (S12CMPAI) Enable AD conversion compare interrupt B (S12CMPED)

Group BL1 priority

Right-alignment ~
Disable automatic clearing ~
12-bit accuracy ~
Addition mode ~
1-time w
(O Enable

O Enable comparison window B

Window A comparison condition matched OR window B comparison condition matched

o

o

Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value
Reference data 0 > A/D-converted value

Reference data 0 > A/D-converted value

o
o
Unused

Reference data 0 > A/D-converted value

0183 (ns)  (Actual value: 0.183)

0.183 (psd  (Actual value: 0183
0.183 (psy  (Actual value: 0183
0.183 (psd  (Actual value: 0183
0.183 (psy  [Actual value: 0.183)
0.183 (psd  (Actual value: 0183
0.183 (psy  [Actual value: 0.183)
0.183 (psd  (Actual value: 0.183)

(Total conversion time: 0.567ps)

Level 15 (highest)

Figure 4-44 Config_S12AD0 setting (2)
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4.7 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed at Pins page.

Pin configuration

Hardware Resource = laz 6‘% A

_,#ﬂ All ~

¥ Clock generator
i Clock frequency accuracy measurement

¥ Operating mode control
_-F-_ System control

®F Interrupt controller unit

w A Multi-function timer pulse unit 3
n MTUO

w MTUI

n MTUZ

n MTU3

N MTU4

n MTUS

w MTUG

w MTU7

n MTUB

& Port output enable 3 v
< >

Pin Function Pin Number

Overview | Board | Clocks | System | Components | Pins | Interr

Figure 4-45 The ‘Pins’ tabbed page

471 Change pin assignment of a software component

52

To change the pin assignment of a software component in Pin Function list. Click to change view to show

by Software Components.

Pin configuration

Hardware Resource = laz

Type filter text

Figure 4-46 Change view to show by Software Components
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Select the Config_ICU of software component. In the Pin Function list -> Assignment column, change the pin
assignment IRQ9 to P91, IRQ10 to P92. Ensure the ‘Enable’ tick box of IRQ9 and IRQ10 are checked, as
shown in Figure 4-47.

Software Components =l l-'iz 42| || Pin Function ~d | | i‘ﬂ | B3 e
Type filter text type filter text (* = any string, ¥ = any character) All w
v -7',: r_bsp Enabled  Function Assignment Pin Mumber Direction Remarks
W r_bsp . .
- r I
« % Compare Match Timer O IRQO # Not assigned Not assigned  Mone
"'. Confio CMITO O R # Mot assigned # Mot assigned  None
onfi
o e JQ-CM“ 0O rae # Mot assigned # Notassigned None
ity R # Not assigned # Notassigned None
onfi
o O IRQ4 # Mot assigned # Notassigned  MNone
v Interrupt Controller
Tl ] IRQS # Not assigned # MNotassigned Mone
onfi
#"Pfrt i O IRas # Notassigned # Notassigned MNone
v orts
o > Confia PORT ] IRQ7 # Not assigned # Mot assigned  None
onfi
;:I’SCIFE_ h Mod ] IRQ8 # Mot assigned # Mot assigned  Mone
MEE "c ) S’S;E;D'°”°“5 ece IRQ9 [F PoAT /s RGe ] # 129 I
onfi
& 9- . IRQ10 [F_Pez/A1e/POEAZ/RAD7; SMISO7/55CL7/IRQ10 ]# 128 I
v ﬁ‘; SPI Clock Synchronous Mode (3-wire method) 0 RQ11 7 Mot mssianed 7 Notassianed N
n . # Mot assignex ot assignes one
Config_SCI6
oAb 0O o 7 Not assigned 7 Notassigned  None
w ingle Scan Mode
= “gC 0 S12AD0 O IRQ13 # Not assigned # Notassigned Mone
onfi
& 9 O  IRQu 7 Notassigned # Notassigned None
O IRQ15 # Mot assigned # Notassigned  MNone
O ww # Mot assigned # Mot assigned  Mone
< >
Pin Function  Pin Number

Figure 4-47 Configure pin assignment - Config_ICU

Select the Config_SCI10 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD10 and TXD10 are checked and Assignment column of RXD10 is P86 and TXD10 is
P87 as shown in Figure 4-48.

Software Components B |8 gk PinFunction 2 | | -;I_:H e e

Type filter text type filter text (* = any string, ¥ = any character) w
¥ ¥ ¥ ¥

hd -'f,: rbsp Enabled  Function Assignment Pin Mumber Direction Remarks
w1 bsp . .
- . CTs10# # Mot assigned # MNotassigned MNone
x G Match T
¥ _0'1“'_5 ;r\;m fmer RTS10# 7 Notassigned # Notassigned None
ontl
- "q_CMﬁ RXD10 7 _Pag/MTIOCAD, TIOCAQ/SMISG10/SSCL10/RXD10/SMI| # 41 I
onme SCK10 # Not assigned # Not assigned  None

Config_CMT2
W Contig_| TXD10 [ B/ MTICCAC TIOCAS/SMOST0/550A10TXD10/SMY # 39 o
v f; Interrupt Controller

& Config_ICU
v f; P_\:jrts
@& Config_PORT
+ . SCI/SCIF Asynchronous Mode
& Config_SCl10
- ﬁ; SPI Clock Synchronous Mode (2-wire method)
& Config_5Cl6
w gt Single Scan Mode 512AD

& Config_S12AD0

8 ]

Pin Function  Pin Number

Figure 4-48 Configure pin assignment - Config_SCI10
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Select the Config_SCI6 of software component. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is P02, SMOSI6 is P00
as shown in Figure 4-49.

Software Components =l laz 42| || Pin Function ~d | | iﬂ' B3 e

Type filter text type filter text (* = any string, ¥ = any character) All w
v -7',: r_bsp Enabled  Function Assignment Pin Mumber Direction Remarks

wi b

ek . SCKe | T G 17 & 10
v & Compare Match Timer
"". Confia CMTo ] SMISO6 # Not assigned # Not assigned  None
onfi

G "g_CMT1 SMOSIE L#_Poo/TMRI0/ TXDE/SMOSIE/SSDAE/ IRGE/AN 111 | ] [e]

& CZ:—':E:(MTZ O SSe# # Not assigned # Not assigned MNone
v g Interrupt Controller

& Config_ICU
v o Ports

& Config_PORT
w gt SCI/SCIF Asynchronous Mode

& Config_SCI0
+ . 5Pl Clock Synchronous Mode (3-wire method)

& Config_SCl6
v 2% Single Scan Mode $12AD

.f Config_S12AD0

< >
Pin Function Pin Number

Figure 4-49 Configure pin assignment - Config_SCI6

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO0# and ANOOO are checked and Assignment column of ANOOO is P40, ADTRGO# is
P07 as shown in Figure 4-50.

Software Components =] laz &% || Pin Function ~d | | _;‘;H B3 e
Type filter text type filter text (* = any string, ? = any character) Al -
hd -'f,: rbsp Enabled  Function Assignment Pin Mumber Direction Remarks
[ b
% Conm Match i ADTRGOF T PR/ ADTRGEE 7 12 I
w ompare Match Timer
o ANOO [P roeAnon ] 7 1 I
ontl
.. JQ-CM“ O ANoot # Not assigned # Notassigned None
& CDH"g_[MTZ O AMNOO2 # Not assigned # Not assigned  None
onftl
" 9- O AMo03 # Mot assigned # Notassigned Mone
v g Interrupt Controller
> Confio ICU O AMNOO4 # Not assigned # Not assigned MNone
ontl
r’*:rt 9- O AMO00S # Mot assigned # Notassigned  MNone
v ors
""; Confia PORT O AMNDOE # Not assigned # Not assigned MNone
onfig_| . .
ANoO7 # Mot d # Not d N
v 2 SCI/SCIF Asynchronous Mode u orasagne o assigned | ~one
& Config_SCI0
- ﬁ‘; SPI Clock Synchronous Mode (2-wire method)
& Config_5Cl6
+ . Single Scan Mode $124D
& Config_512AD0
< >
Pin Function  Pin Number

Figure 4-50 Configure pin assignment - Config_S12AD0

Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘] Generate Code’ at location of Figure 4-51.

{85 SC_Tutorial.scfg 53 = =

Pin configuration

Figure 4-51 Generate Code Button
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If the Section Setting Dialog is displayed as shown in the Figure 4-52, Please check the box and click “Yes”.

Section Setting

.

f ‘-I Current section setting of project may not be compatible with Smart Configurator

&Y' Do you want to change section setting?

Current section setting:

B_1,R_1,8_2,R_2,B,R B_8,R_8,5U),5//4, PResetPRG/FFE00000,C_1,C_2,C.C_8,C$DSEC, C$BSE
C,C3INIT,C3VTBL,CSVECT,D_1,D_2,D,D_8,PPIntPRG,W_1,W_2,W, L/FFE00100,EXCEPTVECT
/FFFFFF80,RESETVECT/FFFFFFFC

New section setting:

SU,SI,B_1,R_1,B_2R_2 B,R B_8,R_8/0x00000004,C_1,C_2,C,C_8,C4* D" W* L, P*/0x FFE0D0D
0, EXCEPTVECT//0x FFFFFF80, RESETVECT/0x FFFFFFFC

[Yes] to change section setting

[No] to keep current section setting

[Cancel] to cancel code generation
DD not show again;

Yes No Cancel

The Console pane should report ‘Code generation is successful’, as shown Figure 4-53 below.

Figure 4-52 Section Setting Dialog

After execution, close Smart Configurator and return to CS +.

& Console &2

Smart Configurator Cutput

Me4@@0001: File generated:src\smc gen‘general\r cg userdefine.h
M@4808881: File generated:src\smc genlgeneral\r smc entry.h
Ma40@@881: File generated:srcl\smc gendgeneralr cg hardware setup.c
Me4000001: File generated:src\smc gen‘general\r cg cmt.h

Me4@eeeal: File generated:
Ma4p@eeel: File generated
Ma4@eeeel: File generated
Ma4@eeeal: File generated
Ma4p@eeel: File generated:s
Me4868081: File generated:src\smc gen\generalir cg rspi.h

Meseeeel2: File generated:src\smc gen\r pincfghpPin.h

Me5eeee12: File generated:src\smc gen\r pincfg\Pin.c

MB6eeeee2: File generated:srcl\smc genhgeneralhr smc interrupt.c

Mece@eee2: File generated:src\smc gen‘generalhr smc interrupt.h

MB6BRaeeR2: File generated:src\smc genhr confighr bsp interrupt config.h
M@RRREee2: Code generation is successful:C:\Workspace\SC Tuteriallsrchsmc gen
Ma3eeeeas: File modified:src\smc_gen\r_confighr_bsp_config.h

src\sme genlgeneralhr cg emtw.h
rc\smc_gengeneralhr cg icu.h
rchsme gengeneral\r cg pert.h
rc\sme_gen\generalhr cg sl2ad.h
rc\smc_genhgeneralhr cg sci.h

=

Figure 4-53 Smart Configurator console

When code generation is executed, the startup files generated at the time of CS+ project creation are
replaced with those generated by Smart Configurator. Figure 4-54 the project tree after code generation. In
the next chapter, user code is added to these files, and SC_Tutorial is completed by adding a new source file

to the project.

Figure 4-54 Smart Configurator folder structure

Project Tree 3 x
t @ 8|E
=] _ﬁ SC Tutorial (Project]*
9 R5F5671EHKFE (Microcontroller)

;.\I Smart Configurator (Design Tool)
- Ay CC-RX (Build Tool)
g RX Simulator (Debug Tool)
? Program Analyzer (Analyze Tool)
=-[J File

i-&] SC_Tutoriale

& : Smart Configurator
j--|_l general
oL rbsp
j--|_l r_config
j--|_l r_pincfg
5[] Config_CMTO
7. Config_CMT1
5. || Config_cmT2
5| || Config_iCU
5| | Config_PORT
5| || Config_512AD0
5| || Config_sCin0
5[]l Config_sCle
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5. Completing the Tutorial Project

5.1 Project Settings

In the ‘Project Tree’ pane, select
‘CC-RX (Build Tool). The build
properties will appear in the main
window.

Project Tree

; @ 2@

EI,_ﬁ 5C Tutorial (Project]”

=

3P File

% R5FS671EHXFE (Microcontroller)
Smart Configurator (Design Tool)

. RX Simulator (Debug Tool)
T) Program Analyzer (Analyze Tool)

CS+ creates a single build
configuration called ‘Default Build’ for
the project. This has standard code
optimisation turned on by default.

4, CC-RX Property

~ Build Mode

Build mode

Change property value for all build modes at once
CPU

Instruction set architecture

Uses single-precision floating-point operation instructions
Uses double-precision floating-point operation instructions
Endizan type for data

Rounding methed for floating-point constant cperations
Handling of denormalized numbers in floating-point constants
Precision of the double type and long double type
Replaces the int type with the short type

Sign of the char type

Sign of the bit-field type

Selects the enumeration type size automatically

Order of bit-field members

Build mode
Selects the build mode name to be used during build.

DefaultBuild
No

Ri¥v 3 architecture(4sa=ncv3)

Yes(fpu)

Yes(-dpfpu)

Little-endian data(-endian=little)

round to nearest(-round=nearest)
Handles as zeros(-denomalize=off)
Handles in single precision(-dbl_size=4)
No

Handles as unsigned char(-unsigned_char)
Handles as unsigned{-unsigned_bitfield)
No

Allocates from right{bit_order=right)

', Common Options / Compile Options AzzembleOptions Link Options Hex Qutput Options Library Generate
Select the ‘Compile Options’ tab at “sgfﬂmneﬂv
the bottom of the properties window | | perrprmr=rrs ]
Language of the C++ source file C++{{ang=cpp)

pane. Under ‘Language of the C
source file’ select ‘C99(-lang=c99)’
as shown opposite.

Additional include paths

System include paths

Include files &t the head of compiling units

Macro definition

Invalidates the predefined macro

Enables information-level meszzage output

Suppresses the number of information-level messages

Undisplayed messages

Changes the warning-level messages to information-level messages
Changes the information-level messages to warning-level messages

Language of the C source file
Selects language of the C source file.
This corresponds to the -lang option of the compiler.

Additional include paths[17]

System include paths[0]

Include files at the head of compiling units[0]
Macra definition [0]

No[-nomessage)

No
No

\ Common Options _}ICompileOptionsI{ AssembleOptions ,( Link Options ,( Hex Qutput Options ,( Library Generate C

Select the ‘Link Options’ tab at the
bottom of the properties window
pane. Under ‘Section -> ROM to
RAM mapped section’, add the three
mappings as shown opposite.

~ Section
Section start address
The specified section that outputs externally defined symbols to the file
Section slignment

SU.SLB_1.R_1.B_2R_2B.R.B_8.R_8/4C_1C 2CC 8CS.D"W",
The specfied section that oLtputs extemally defined symbols to the file[0]
Section alignment[0]

ROM to RAM mapped section ROM to RAM mapped section[4] =

Verify
Others

ROM to RAM mapped section

Specifies ROM to RAM mapped section in the format of "<ROM section name>=<RAM section name>", one per line.

This correspends to the -rom optien of the linker.

% Common Opticns / Compile Options

AssembleOptions | Link Options |{  Hex Output Options

Library Generate Options
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5. Completing the Tutorial Project

e These settings are easily added by
clicking the button ‘..." and pasting
the following text into the dialog:

D=R

D_1=R_1
D_2=R 2
D_8=R 8

e This ensures that the linker assigns
RAM rather than ROM addresses to
C variables. Click ‘OK’

e From the ‘Build’ menu, select ‘Build
Mode Settings...”. Click ‘Duplicate’
and in the resulting ‘Character String
Input’ dialog, enter ‘Debug’ for the
name of the duplicate Build Mode.

Build Project
Rebuild Project
Clean Project

Rapid Build

Update Dependencies

=-|f SC Tutorial (P
3% RsFse71EH

Build SC_Tutorial
Rebuild SC_Tutorial
Clean SC_Tutorial

08 @ ¥
z

Update Dependencies

Stop Build

Set Link Order of SC_Tutorial...

Open the Optimization Performance Comparison Tool for SC_Tuterial...

F7
Shift+F7

of SC_Tutorial

Cirl+F7

Build Mode Settings...

Batch Build...

+ Build Opticn List

|_-|]| Cor

Build Mode Settings

Selected build mode

Build mode list:

DefaultBuild

Duplicate. ..

Character String Input

String
Debug
Heb Coree | [t
‘ ’ H : d a »
e The new ‘Debug’ Build Mode will be | |% cofxfeey
~ Buil
added to the Build Mode list. Click T 0c'ot5.id v
. . Change property value for all build modes at once Default Build
‘Close’. Now, in the main CC-RX
. y - v CPU
. Instruction set architecture TAVS dICTIECTONET- T
Property WI nd OW, u nder the Uses single-precision floating-point operation instructions Yes({pu)
‘ H ’ H Uses double-precision floating-point operation instructions Yes(-dpfpu)
Com mon Optlons tab’ CIICk On the Endian type for data Little-endian data(-endian=little)
i ini ¢ H ’ H Rounding methed for floating-peint constant operations round to nearest(tound=nearest)
line Contammg Build Mode ’ click the Handling of denormalized numbers in floating-point constants Handles as zeros(denomalize=off)
pU”-dOWﬂ arrow and select ‘Debug’ Precision of the double type and long double type Handles in single precision(dbl_size=4)
, Replaces the int type with the short type No
from the pu||-down . Sign of the char type Handles as unsigned char(unsigned _char}
Sign of the bit-field type Handles as unsigned {unsigned_bitfield)
Selects the enumeration type size automatically No
Order of bit-field members Allocates from right (bit_order=right)
Assumes the boundary alignment value for structure members is 1 Nof-unpack)
Build mode
Selects the build mode name to be used during build.
‘ICnmmnn Optionsl Compile Options AssembleOptions Link Options Hex Output Options Library Generate Options
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Renesas Starter Kit+ for RX671 5. Completing the Tutorial Project

e In the ‘Frequently Used Options (for | “ cfxeerey al 1ol =
Compile)’”  group, select  the Build mode Debug

Change property value for 3l build modes at once No
CPU

‘Optimization Level’ option and select

‘0’ from the pull-down. We have NOW | | oupstFieTyseamdpan

created a ‘Debug’ Build Mode with ermeivs et lder atodme
no code optimisation and will be ||~ e R ——
using the Build Mode to create and System ncludepabe Sy o]
debug the project. Outputs debuaging information Yes(<ebug)

Optimization level
Outputs additional infarmation for inter-module optimization
Optimization type

Outputs a source list file

~ Frequently Used Options(for Assemble)

2(-optimize=2)
Of-optimize=0)
1(-optimize=1)
2(-optimize=2)
Max(-optimize=max)

e Al of the sample code projects | “ fxrees al 8] =
contained in this RSK+ are Build mods _ Release
configured with three Build Modes; S "
‘DefaultBuild’, ‘Debug’ and ‘Release’. | | ouriteTypemiran
‘Release’ is created in the same way et e ctput lder T
as above; by duplicating ‘Default ||~ Eﬁﬂﬁ:ﬂiﬁﬁfﬂhw'ﬁ Actional nclude pathel 171
Build’. ‘Release’ Build Mode leaves Syseminclde pahs Sy e pal]
code optimisation turned on and Outpuis debugging informaion Yes(debug)
removes debug information from the e s opal et o el ssnizston [P
output file. e s s oo

. . Frequently Used Oplons(for Assemble)
e To remove debug information from | |+ FreauentlyUseiOpionsforLink)

‘ y . . . Using libraries Using ibraries[0]
the ‘Release’ Build Mode, in the ‘CC- Yes?Oulpulslmheumpulhle)[—DEEug)
RX Property’ window, select the 5:27‘2:3':; :g:?ess ::: :33i‘:iiﬂhfm”ffﬁf!mfii)ME (-5 Debug
‘Common Options’ tab at the bottom | | Freauenty sed Opfoms(iox Hox i) fetupe

of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).

e Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

e From the menus, select ‘File -> Save
All' to save all project settings.

5.2 Additional Folders

e Before new source files are added to ”“’ - —
. . z K g -]
the _ .prOJect, we. will create ?wo
additional folders in the CS+ Project 8 RorsoriEHF| | Buld SCTutoral
T | Smart Config] §] Rebuild SC_Tutorial
ree' --ﬂg;—:X(B‘u\\d j} Clean SC_Tutorial
. . . 4 imulator
e In the Project Tree pane, right-click 3 Program Ana| B! Open Folder with Explorer
the SC_Tutorial project and select Ei‘ﬂjsc I - | o e
‘Add -> Add New Category’. 3 smert Corl__262 DR Add Subproject..
rﬂ Set SC_Tutorial as Active Project +ﬂ Add New Subproject...
[#7 Save Project and Development Tools as Package... [} AddFile..
# paste cil=v  |1F] Add New File..
## Rename F2 (1! Add New Category
Property
e Rename the newly-created ‘New e e e
3 ‘ A ) A ™ ¢ =
Category’ folder to ‘C Source Files’. : @8 @
Repeat these steps to create a new =13 5C Tutortal (Project)” _
f N R5F5671EHxFB (Microcontroller)
Category f0|der for DependenCIeS . 4 Smart Configurator (Design Tool)
4,, CC-RX (Build Tool)
R¥X Simulator (Debug Tool)
’:) Program Analyzer (Analyze Teol)
&30 File
-] SC_Tutorial.c
_l Smart Configurator
e
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Renesas Starter Kit+ for RX671 5. Completing the Tutorial Project

5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h

Copy these files in to the src folder below the workspace and then follow the steps below.

» Move the ‘SC_Tutorial.c’ file from B % B - scTutorial
‘C:\Workspace\SC_Tutorial’ to L Home | Share  View
‘C:\WorkSpace\SC_Tutorial\SrC'. &« v P » ThisPC » Local Disk (C:) » Workspace » SC_Tutorial
Name - Daten
7 Quick access et
Debug
I3 This PC DefaultBuild
[ Desktop Release _A
£ Documents £l &= -
; Downloads g dbsct.c
J’ Music g hwsetup.c
. _|intprg.c
&=/ Pictures j iodefine.h
B videos \:] lowlvl.src
%5 Local Disk (C:) “Nowsre.c
=¥ Network g lowsrc.h
N | resetprg.c
j shrk.c
1 shrk.h
[ SC_Tutorial #5032, mtud
&) sC_Tutorial.mtpj

« Select SC_Tutorial.c on the project tree, Right-
click and select 'Remove from Project' to : 03 @
= B—
exclude it from the project. =03 5C Tutorial (Project

¥ RsFsE71EHXFB (Microcontraller)
;‘l Smart Cenfigurator (Design Tool)
4, CC-RX (Build Tool)
& RX Simulator (Debug Tool)
; ’:) Program Analyzer (Analyze Tool)
=-[3l File

g
[]) smart Con é Compile
I_E C Source F

Open

Open with Internal Editor...

Open with Selected Application...
Open Folder with Explorer

IEME&KLJ

Windows Explorer Menu

Add k

] Remove from Project Shift+Del

« Right-click on the ‘C Source Files’ folder and é"’ﬂ&fgmcm - H
select ‘Add’ -> ‘Add File...". =

...... [] Dependenci __ Add Wi AddFile.. |
kil Open Folder with Explorer 1] Add New File...

Windows Explorer Menu |:|_, Add New Category
Remove from Project Shift+Del

iy Copy Ctrl+C

1| Paste Ctrl+V
Rename F2
Property

R20UT4882EG0100 Rev. 1.00 RENESAS Page 43 of 69

May.10.21



Renesas Starter Kit+ for RX671
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« Select the files to be added (ascii.c,
r_okaya_lcd.c, SC_Tutorial) from C:
\Workspace\SC_Tutorial\src.

@ Add Existing File

« v 4 « Workspace » S5C_Tutorial » src » v Search src pel
Organize « Mew folder Bz~ ™ @
Mame
7 Quick access
smc_gen
B This PC 7 ascii.c
[ Desktop j r_okaya_lcd.c
Documents E SC_Tutorial.c
¥ Downloads
D Music
&= Pictures
B videos
‘i Local Disk (C:)
=¥ Network
< >
File name: | "SC_Tutorial.c” "ascii.c" "r_okaya_lcd.c" v| C source file (*.c) ~

« Similarly, add ‘ascii.h’ and ‘r_okaya_lcd.h’ to the
'Dependencies' folder.

Note: Select the Header file (* .h; * hpp; * .inc).

@ Add Existing File

« v 4 « Workspace » S5C_Tutorial » src » v Search src pel

Organize « Mew folder Bz -

Mame
7 Quick access
smc_gen
j ascii.h
j r_okaya_led.h

I This PC
[ Desktop
Documents
¥ Downloads
D Music
&= Pictures
B Videos
‘i Local Disk (C:)

=¥ Network

< >

File name: ‘"r_okaya_\(d.h” "asciih" v| IHeader file (*.h; *hpp; *.inc) VI

Cancel

« Make sure the project tree is the same as the
screen shot.

Project Tree B X
; @ 2|[&E
E[_f. SC Tutorial (Project)”
.3 % RSFSET1EHxFB (Microcontroller)
----- ':_,j Smart Configurator (Design Tecl)
..... 4o CC-RX (Build Tool)
----- g, RX Simulator (Debug Tool)
..... ‘3‘ Pregram Analyzer (Analyze Tool)
=3 File

|_-ﬂ| Smart Cenfigurator

----- ‘_:J r_okaya_lcd.c
L& SC_Tutoerial.c
E| E Dependencies
..... b= ascii.h

----- i'_J r_ckaya_lcd.h

o |
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Renesas Starter Kit+ for RX671 5. Completing the Tutorial Project

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart
Configurator-generated code.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’ by double-clicking
on it. Add header files above the ‘main’ function as shown below.

#include "r smc_entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R LCD Display (0, (uint8 t *)" RSK+RX671 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");
while (1U)

{

}

Indentation is lost when the code described in this manual is pasted into the CS+ source file. Also check that the
pasted code is correct.
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in §4.5.6. In
the CS+ Project Tree, expand the ‘Smart Configurator/Config_SCI6’ and open the file ‘Config_SCI6.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */

Now, open the ‘Config_SCI6_user.c’ file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t s sci6 txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:
static void r Config SCI6 callback transmitend(void)
{
/* Start user code for r Config SCI6 callback transmitend. Do not edit comment generated here */

s _sci6_txdone = TRUE;

/* End user code. Do not edit comment generated here */

}
Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

J Rk Kk ok kA KRR A A K KAk k ok h ok kKA XA E Kk khhh kA AAA KA KA KKk k ok k ok kA XA KKK K&k kK kkkokkx

* Function Name: R_SCI6_ SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/

MD STATUS R _SCI6 SPIMasterTransmit (uint8 t * const tx buf,
const uintl6_t tx num)
{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s _sci6_txdone = FALSE;

/* Send the data using the API */
status = R Config SCI6_SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s sci6_ txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R SCI6 SPIMasterTransmit

KAk Ak Ak kA kA kA Ak A A Ak A A A A A A A A A A A A A A A A A A A A A A A KA KA A A A KA KA A A A KA KA KA A KA KA K I A KA KA KK A KK

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in §4.5.2. In the CS+ Project Tree,
expand the ‘Smart Configurator\Config_ CMTO\Config_ CMTO0.h’ and insert the following code in the user area
for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t s one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config CMTO_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiO_ interrupt (void)
{
/* Start user code for r Config CMTO cmiO_interrupt. Do not edit comment generated here */

s_one _ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

[ KKk k ok ok kKA A A A KKKk ko k k ok ok kKA A AR KA KKKk ok k k k ok ok kA AR A KA KKKk kK kkk ok kAR AR A KKKk Kk k ok ok ok ok ok

* Function Name: R_CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
‘k‘k‘k‘k*******‘k‘k‘k‘k‘k‘k‘k********‘k‘k‘k‘k‘k‘k********‘k‘k‘k‘k‘k‘k‘k********************************/
void R _CMT MsDelay (const uintlé t millisec)

{

uintlé t ms count = 0;

do

{
R Config CMTO_ Start();
while (FALSE == s one ms_delay complete)
{

/* Wait */

}
R Config CMTO Stop();
s_one_ms_delay complete = FALSE;
ms_count++;

} while (ms_count < millisec);

}

KKK KK K kK K K Kk K K R K R kK K K K R kK R R R kK R R R ok K R R R kK R R R kK R R R Rk R Rk Rk kR Rk Rk kK

End of function R CMT MsDelay
*******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The program will display ‘RSK+RX671
Tutorial Press Any Switch’ on 3 lines in the LCD display.
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54 Switch Code Integration

API functions for user switch control are provided with the RSK+. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx671def.h
-r_rsk_switch.c
-r_rsk_switch.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

The switch code uses interrupt code in the files Config_ICU.c, Config_ICU_user.c and Config_ICU.h and timer
code in the files Config ICU.c, Config ICU_user.c, Config CMT1.h, Config_ CMT1.c, Config CMT1_user.c,
Config_ CMT2.h, Config_ CMT2.c, and Config CMT2_user.c, as described in §4.5.2 and §4.5.3. 1t is
necessary to provide additional user code in these files to implement the switch press/release detection and
de-bouncing required by the API functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Smart Configurator/Config_ICU’ folder and open the file ‘Config_ICU.h’
by double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);
void R _ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the ‘Config_ICU.c’ file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

VARREEEEEE LSRR EEE St EEEE Rt EEE Rt EE R E

* Function Name: R_ICU_ IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU IRQ is set to

* falling edge triggered, otherwise 0.

* Arguments : uint8 t irg no

* Return Value : 1 if falling edge triggered, 0 if not
*******************************************************************************/

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no)
{
uint8_t falling edge trig = 0x0;
if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE FALLING)

{
falling edge trig = 1;
}

return (falling edge trig);
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R_ICU_IRQIsFallingEdge

LR EEEEE RS AR EEEE LR AR R EEEE R EE Rt

VAREEEEEEE RS SRR R R LA EEE Rt EEE Rt EE Rt

* Function Name: R_ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k~k**********************~k~k~k~k~k~k~k~k~k~k***********************/

void R ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE FALLING;
}

else

{
ICU.IRQCR[irg no].BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R ICU IRQSetFallingEdge

LR EEEE RS SRR EEE SR EEEE R EEEE R R Rt

VAREEEEEEE SRR EEE Rt EEE Rt EEEEE R R R Rt

* Function Name: R ICU IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/
void R ICU IRQSetRisingEdge (const uint8 t irq no, const uint8 t set r edge)
{
if (1 == set_r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;
}
else
{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;
}
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R _ICU_IRQSetRisingEdge

LR R EEE R RS EEEEE SRR EE AR EEE R R Rt

/* End user code. Do not edit comment generated here */
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Open the ‘Config_ICU _user.c’ file and insert the following code in the user code area for include near the top
of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq9_interrupt:

/* Start user code for r Config ICU irqg9 interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg10_interrupt:

/* Start user code for r Config ICU irglO_interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */
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5.4.2 De-bounce Timer Code

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT1’ folder and open the ‘Config_ CMT1_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the ‘Config_ CMT1_user.c’ file insert the following code in the user code area inside the function
r_Config_ CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config_ CMT2’ folder and open the ‘Config_ CMT2_user.c’
file and insert the following code in the user code area for include near the top of the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file and insert the following code in the user code area inside the function
r_Config_ CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */
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543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In §4.5.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following code the user code area, resulting in the code shown below

/* Start user code for function. Do not edit comment generated here */

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘C Source Files’ folder and Open the file ‘SC_Tutorial.c’ and add the
highlighted code, resulting in the code shown below:

#include "r smc entry.h"
finclude "r okaya lcd.h
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6é t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the
code shown below:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Init();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX671 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0_Start();

while (10U)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R_Config S12AD0_Get_ ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}
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Then add the definition for the switch call-back, get_adc and lcd_display_adc functions adding at the below of

the main function, as shown below:

KA KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A Ak Ak Ak Ak kK, Kk

* Function Name : cb switch press

* Description : Switch press callback function. Sets g adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/
static void cb switch press (void)
{

/* Check if switch 1 or 2 was pressed */

if (g_switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))

{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;
}
}

/******************************************************************************

* End of function cb switch press
******************************************************************************/

/******************************************************************************

* Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintlé t adc value

******************************************************************************/
static uintl6é t get adc (void)

/* A variable to retrieve the adc result */
uintlé t adc result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0 Stop();

/* Start a conversion */
R S12AD0 SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc_complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R _S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R Config S12AD0 Start();

return (adc_result);

}

/******************************************************************************

* End of function get adc
******************************************************************************/
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/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/
static void lcd display adc (const uintl6é_t adc_result)
{

/* Declare a temporary variable */
char t a;

/* Declare temporary character string */
char t lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char_t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (a < 0x0A) 2 (a + 0x30) : (a + 0x37);
a = (char_t) ((adc_result & 0xO00FO0) >> 4);

lcd buffer[7] = (a < 0xO0A) ? (a + 0x30) : (a + 0x37);
a = (char t) (adc_result & 0x000F);

lcd buffer[8] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);

/* Display the contents of the local string lcd buffer */
R _LCD Display(3, (uint8 t *)lcd buffer);

}

/******************************************************************************

* End of function lcd display adc

******************************************************************************/

In the CS+ Project Tree, expand the ‘Smart Configurator\general’ folder and open the file ‘r_cg_userdefine.h’
by double-clicking on it. Insert the following type define in between the user code delimiter comments as
shown below.

/* Start user code for type define. Do not edit comment generated here */

typedef char char t;

/* End user code. Do not edit comment generated here */

In the Project Tree, expand the ‘Smart Configurator\Config  S12AD0O’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void);
void R S12AD0 SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */
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Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, resulting in the code shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStart

* Description : This function starts the ADO converter.

* Arguments : None

* Return Value : None
*******************************************************************************/

void R _S12AD0_SWTriggerStart (void)
{
IR (PERIB, INTB183) = 0U;
IEN (PERIB, INTB183) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***************************

End of function R S12AD0_ SWTriggerStart

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k**************************/

VAREEEEEE RS EREEEEEEE Rt R R R EE Rt EEEEE Rttt EEE Rt

* Function Name: R _S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None

* Return Value : None
*******************************************************************************/

void R S12AD0_SWTriggerStop (void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN (PERIB, INTB183) = 0U;
IR(PERIB, INTB183) = 0U;

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***************************

End of function R S12AD0 SWTriggerStop

LR EE SRRt R R R R EE R R R R EE Rt EEEEE Rt EE Rt

/* End user code. Do not edit comment generated here */

Open the file ‘Config_S12ADO0_user.c’ and insert the following code in the user code area for global, resulting
in the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_Config_S12ADO0 _interrupt function, resulting in the
code shown below:

static void r_ Config S12AD0_interrupt (void)
{
/* Start user code for r Config S12AD0_interrupt. Do not edit comment generated here */

g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the RV1 potentiometer line and display the
result on the LCD panel. Return to this point in the SC_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK+ serial port are provided with the RSK+. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

-r_rsk_debug.c

-r_rsk_debug.h

Copy these files in to the src folder below the workspace. Add these files into the project in the same way as
the LCD files as in section 5.3.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_DEBUG WRITE (R _SCI10 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration

5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Smart Configurator\Config_SCI10’ folder and open the file
‘Config_SCI10.h’ by double-clicking on it. Insert the following code in the user code area at the end of the file:
/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI10 AsyncTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI10_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t s scilO_ txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI10_callback_transmitend function:

static void r Config SCI10 callback transmitend (void)
{
/* Start user code for r Config SCI10 callback transmitend. Do not edit comment generated here */

s _scil0 txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area
inside the r_Config_SCI10_callback_receiveend function:

static void r Config SCI10 callback receiveend(void)

{

/* Start user code for r Config SCI10 callback receiveend. Do not edit comment generated here */

/* Check the contents of g rx char */
if (('c' == g rx char) || ('C' == g rx char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI10 receive buffer and callback function again */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/‘k‘k‘k‘k‘k‘k*************************************************************************

* Function Name: R SCI10 AsyncTransmit

* Description : This function sends SCI10 data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx_num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

***********************:********:**********************************************/
MD_STATUS R_SCI10_AsyncTransmit (uint8 t * const tx_buf, const uintl6_t tx_ num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s_scilO_txdone = FALSE;

/* Send the data using the API */
status = R Config SCI10 Serial Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s_scilO_txdone)
{
/* Wait */
}
return (status);

}

/*******************************************************************************

* End of function R SCI10 AsyncTransmit

R R R e 3
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5.6.2 Main UART code

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to above the ‘main’ function:

#include "r smc entry.h"
#include "r okaya lcd.h"
finclude "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI10.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintlé_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6é t adc_ result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc count = 0;
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Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R_SWITCH TInit();

/* Set the call back function when SW1l or SW2 is pressed */

R_SWITCH_ SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display (0, (uint8 t *)" RSK+RX671 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI10 receive buffer and callback function */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R Config SCI10_Start();

while

{

(10)

uintlé_t adc_ result;

/* Wait for

if
{

}

/* SW3 is directly wired into the ADTRGOn pin so will

(TRUE == g adc_ trigger)

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s_adc_count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}
/* Send the result to the UART */
uart display adc(s_adc_count, adc result);

/* Reset the flag */
g_adc_trigger = FALSE;

cause the interrupt to fire */

else if (TRUE == g adc_complete)

{

}

/* Get the result of the A/D conversion */

R Config S12AD0 Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s _adc_count */
if (16 == (++s_adc _count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc count, adc result);

/* Reset the flag */
g_adc_complete = FALSE;

else

{
}

/* do nothing */

user requested A/D conversion flag to be set

(SW1 or SwW2) */
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Then, add the following function definition in the end of the file:

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************************************************

* Function Name : uart display adc

* Description : Converts adc result to a string and sends it to the UARTI1.
* Argument : uint8 t : adc_count

* uintlé_t: adc result

* Return value : none

******************************************************************************/
static void uart display adc (const uint8 t adc_count, const uintlé t adc_result)

{
/* Declare a temporary variable */
char t a;

/* Declare temporary character string */
char t uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char_t) (adc_count & 0x000F);

uart buffer[4] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char t) ((adc_result & 0xO0F00) >> 8);

uart buffer([l4] = (a < 0xO0A) ? (a + 0x30) : (a + 0x37);
a = (char t) ((adc_result & 0xO00FO0) >> 4);

uart buffer[15] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char t) (adc_result & 0x000F);

)
uart buffer([l6] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);

/* Send the string to the UART */
r debug print (uart buffer);

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************************************************

* End of function uart display adc
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. Connect the RSK+ G1CUSBO port to a
USB port on a PC. If this is the first time the RSK+ has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &

LPT)" as 'RSK+ USB Serial Port (COMx)", where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI10 (Baud Rate:

19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘¢’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the RV1 potentiometer line and display the result on the LCD panel and send the result

to the PC terminal program via the SCI10.
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5.7 LED Code Integration

In the Project Tree, expand the ‘C Source Files’ folder and open the file ‘SC_Tutorial.c’. Add the following
declaration to the above the ‘main’ function:

#include "r smc entry.h"
finclude "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI10.h"
#include "rskrx67ldef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc_count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code to the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1l or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R_LCD Tnit();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX671 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0 Start();

/* Set up SCI10 receive buffer and callback function */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R Config SCI10 Start();

while (10)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SWl1 or SW2) */
if (TRUE == g_adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc_result);
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/* Increment the s _adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */

uart display adc(s_adc_count, adc result);

/* Reset the flag */

g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will

cause the interrupt to fire */
else if (TRUE == g adc complete)
{

/* Get the result of the A/D conversion */

R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */
uart display adc(s_adc count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}

Then, add the following function definition at the end of the file:

/******************************************************************************

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDS0-3
* Argument : uint8 t count

* Return value : none

******************************************************************************/
static void led display count (const uint8_t count)

{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint8 t) ((count & 0x01) ? LED ON : LED OFF);
LEDLl = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8 t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8_t) ((count & 0x08) ? LED ON : LED OFF);

}

/**************************************~k***************************************

* End of function led display count
******************************************************************************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The code will perform the same but now

the LEDs will display the s_adc_count in binary form.
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6. Debugging the Project

6.

Debugging the Project

e In the ‘Project Tree’ pane, right-click the | JEEEEMIES 1 x
‘RX Simulator (Debug Tool).  Select 8 B 23
‘Using Debug Tool -> RX E2 Lite’. = F SC Tutorial (Project)”
#, R3F37T2ZMMND=ED (Microcontroller)
. :~I Smart Cenfigurator (Design Toel)
A, CC-RX (Build Tool)
R Simulator Dcbug Tacas]
o ¥ Program Analyzer (An Using Debug Tool  » | RXE2
e (3} File 3 Property | RXELite
L] Build taol generatéurm -
|_]_ Smart Configurator RX E1(Serial)
|_]_ C Source Files RX E1(JTAG)
|_l Dependencies R E20(Serial)
RX E20(JTAG)
RX Simulator
e Double-click ‘RX E2 Lite (Debug Tool) to | FF Property
display the debugger tool properties. :
‘ , . 2 RXEZ2 Lite Property
Under ‘Clock’, change the main clock
. . +w |Internal ROM/RAM
frequency to 24MHz, Communications | | e ECTToYS R -
method ‘JTAG’ and operating frequency to Size of internal RAM[Kytes] 384
’ Size of DataFlash memory[KBytes] 8
120MHz. v Clos
e All other settings can remain at their Main clock source EXTAL
Main clock freguency[MHz] 24_0000
defaults. Operating frequency[MHz] 120.0000
Allow changing of the clock source on wnting internal flash memory No
~ Connectionwith Emulator
Emulator senal No.
+ Connectionwith Target Board
Power target from the emulator. (MAX 200md) No
Communications method JTAG
e Connect the E2 Lite to the PC and the
RSK+ E1/E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.
e Connect the center positive +5V PSU to
the PWR connector on the RSK+ and
apply power.
e From the ‘Debug’ menu select ‘Download’
to start the debug session and download
code to the target.
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7. Running the Smart Configurator Tutorial

71 Running the Tutorial

Once the program has been downloaded onto the RSK+ device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

8. Additional Information

Technical Support

For details on how to use CS+, refer to the help Window | Help|

file by opening CS+, then selecting Help > Help

Contents from the menu bar. 5 -:Tn%|@ Help

-

@+ Open Help for Main window
How to Access Help

qlq Cne Point Advice...

B Tutorial

5«}, Privacy Settings...
(i Detail Version Information..,
Eﬁ Check for Updates...

Launch License Manager...

[EY About...

@] Browse Renesas Electronics Microcentrollers Web

Fi

For information about the RX671 group microcontroller refer to ‘RX671 Group User’s Manual: Hardware'.

For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:

https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe GmbH.

© 2021 Renesas Electronics Europe GmbH. All rights reserved.

© 2021 Renesas Electronics Corporation. All rights reserved.
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